Student/Faculty Information System

BI Publisher

Outline of Steps for Report Developer Role

These are the steps to create a BI Publisher report for Users with the Report Developer role.

Those with the Power User role can perform all of the steps here except for Registering Data Source.

(PeopleSoft 9.0, PeopleTools 8.52)
**BI Publisher – Outline of Steps (Report Developer)**

- **Install Design Helper:** Before you can work with BI Publisher, you need to Install Oracle BI Publisher Desktop through Design Helper. These instructions assume that Design Helper has already been installed.

- **Basic Sequence:** The main phases in the BI Publisher process are these:
  1. Create a query
  2. *Register Data Source* (only available to users with the Report Developer role)
  3. Create a template in Word
  4. Set up Report Definition – associate with Template
  5. Run, View and Save the BI Publisher Report

**Note that once you create the query, you can switch the order in which you perform the second and third phases, i.e., you can first create the template in Word and then register the Data Source.**

- **Other resources:**
  - You will find a number of reference documents in the [PeopleSoft Blog](#).
  - This document is based on more detailed instructions in [Using BI Publisher with PeopleSoft Query for Report Developers](#).
  - There are links within this document to text in the Blog.
1. **QUERY: GENERAL GUIDELINES for Creating or Modifying Queries** to Use with BI Publisher (for either group of users – Report Developer or Power User):

   a. Design how the output should appear and determine which fields are required before creating the query
   
   b. The query should contain all the fields that need to appear in the report.
   
   c. It should also contain fields that will be used in the Word template for grouping purposes, even if they will be hidden in the report
   
   d. Keep the query as simple as possible

      a. However, since the query can be used for multiple templates to create multiple reports, thought should be given to what additional fields may be appropriate for future use

   e. For ease of use when working on the template, arrange the fields in the same order as they will appear on the document
1. **QUERY: GENERAL GUIDELINES for Creating or Modifying Queries** to Use with BI Publisher (for either group of users – Report Developer or Power User):

   f. Do as much formatting as you can within the query itself. For example, it is important that dates and times be formatted through expressions.
   
   g. Change heading text as needed since they may appear in the report
   
   h. Unique Field Name (on the Edit Field Properties page in Query Manager).
      
      a. If there are expressions used in the query or there are other fields that have a Unique Field Name that are somewhat ambiguous, change Unique Field Name since you will be referencing it when creating the template. A simple, clear name will be easier to work with.
      
      i. Prompts may be used in the query. Test the query and note the results for comparison with the report results

- See the entire list of the suggestions about creating a query on page 6 of *Using BI Publisher with PeopleSoft Query for Report Developers* in the section entitled Create a query or modify an existing query.
2. **Register Data Source** - Available to Report Developers only (Reporting Tools > Bi Publisher > Data Source)

   a. Since there is no existing Data Source, click on **Add a New Value**
   b. It should default to a **Data Source Type** of PS Query. If so, you do not have to make a change. Otherwise, select PS Query from the dropdown.
2. **Register Data Source**

c. Next to **Data Source ID** you can type the name of the query, or the first few letters to narrow the selection. Once you’ve done so, the page will resemble the following.

i. To the right is a checkbox labeled **Private Data Source**. This would only be checked if it were a Private Query.
2. **Register Data Source**

d. Once you have typed the query name, click on the **Add** button. The **Data Source** page will open as follows:

![Data Source Page]

e. **Description**: (Optional) Enter descriptive text that provides more detail about the data source. The description automatically defaults to the Data Source ID when you click Save.
2. **Register Data Source**

   f. **Owner ID:** (Optional) Indicate which product, feature, or application owns this data source.

   g. **Registered Date/Time:** This is a read-only field maintained by the system that indicates the date that the initial data source registration was made.

   h. **Last Update Date/Time:** This is a read-only field that indicates the date that the last update to the data source was made.

   i. **Active:** If not already checked, select to indicate that this is an active data source.
      
      i. Only active data sources can be chosen when creating a new Report Definition.

      ii. Only reports with active data sources can be processed.

   j. **Registered By:** This is a read-only field that indicates the user ID of the operator who initially registered the data source.

   k. **Updated By:** This is a read-only field that indicates the user ID of the operator who last updated the data source.
2. Register Data Source

l. Click **Generate** under the **Generate File** column for **Sample Data File**.

m. Click **Generate** under the **Generate File** column for **Schema File**.

n. After the **Data Source** is generated, an XML file for **WOIS_EXT_ORGS_NRS_INTL_ONLY** is created. Click the **Save** button.
2. **Register Data Source**

o. To view the XML file, click the WOIS_EXT_ORGS_NRS_INTL_ONLY.XML link.
   
i. The browser appears and displays the XML file data. Below is the beginning of the XML file.
   
ii. Save the XML file in an appropriate directory. You will be accessing the XML file when you create the Word template.

- See another demonstration of how to register a Data Source starting on page 10 of Creating PeopleSoft Reports Using XML Publisher entitled Create and Register a Data Source.
3. Create a Template in Word
   
a. Once the **Sample Data** (XML file) has been saved, open Word
b. Select **Add-Ins** from the menu

c. To gain access to the XML Data, click on **Data – Load XML Data**...
3. Create a Template in Word

d. Windows Explorer opens. Navigate to the directory where you saved the XML file

e. Click to open the file. When this message appears, click OK.

f. To begin inserting the fields and formatting the template, click on **Insert**.
3. Create a Template in Word

g. The Insert menu appears as follows.
h. There are a number of methods for inserting the fields into the Word template.
i. In addition, there are many ways to format and otherwise refine the final output. The easiest way to display all rows of data is to use the **Table Wizard**.
j. Review the following Oracle documents in the SFIS Blog about inserting fields and creating tables:

i. [Oracle BI Publisher Template Builder for Word 10.1.3.3.0](#) - a quick tutorial showing Insert Table/Form and Creating Charts

ii. [Links to PeopleSoft Recordings on Formatting BI Publisher Template](#) – demonstrations of conditional formatting, formatting dates and numbers, page level calculations, page breaks, pages numbers, and shapes

iii. [XMLP Templates by Example](#) – Insert Table/Form, grouping, totals and tallies, summaries, conditional formatting, formatting numbers

iv. [Creating PeopleSoft Reports Using XML Publisher](#) – Create a Pie Chart and Bar Chart, Create a Table (Table/Form), formatting, calculations
3. Create a Template in Word

k. These are HEUG presentations or instructions from HEUG members with useful template information:
   i. **BI Publisher for the Registrar’s Office** (UNT Health Center) - includes
      a) Basic Techniques
         1) Table Wizard and Sorting
         2) Tables and Formatting
      b) Advanced Techniques
         1) Date Formatting
         2) IF Statements – Conditional Format
   ii. **BI Publisher Course** (Clackamas County) – see Chapter 5, Page 28 about templates. It looks like it comes from the Oracle documentation. These appear to be good overall instructions for using BIP.
      a) Pie Chart, Bar Chart
      b) Create a Table – Formatting

l. In the Wesleyan document **Using BI Publisher with PeopleSoft Query for Report Developers** (under Create a Template in Word) you will find a demonstration of using the Table/Form menu item.
Student/Faculty Information System

BI Publisher – Outline of Steps (Report Developer)

4. Set Up Report Definition (available to both Report Developer and Power User)
   
a. Open Report Definition (Reporting Tools > BI Publisher > Report Definition)

   ![Report Definition Image]

   b. Click on Add a New Value. When the next page opens, enter a Report Name. There is a 12-character limit.

   c. Note that the **Data Source Type** is grayed out for Power Users.
4. Set Up Report Definition

d. **Data Source ID:** In this dropdown box you can search for the query by typing in all or the first few letters of the query name. If you do not type in the entire name, a list of queries will be displayed.

![Data Source](image)

e. Click the Add button. The following group of pages will appear (Note: The Power User will not have the Bursting page).

f. Start with the Definition page by entering a name for the report in Report Description.

g. Under **Report Status**, change **In Progress** to **Active**
4. Set Up Report Definition

h. Under **Report Category ID**, select an appropriate Report Category
i. Set the **Template Type** as RTF if it is not already
j. The Definition page should now appear as follows:
4. Set Up Report Definition

k. Click on the **Template** tab. Notice that the Report Name is displayed at the top. There is now a **Template ID** that consists of the Report Name and ends in “_1.”

l. In order to save the Report Definition, you must associate a template with it.

   i. On the Template page, upload the RTF template by clicking on the Upload button (Note: In Internet Explorer, you may need to hold down the CTRL key at the same time).

   ii. Depending on your browser, a popup menu will appear prompting you to browse for the file.
4. Set Up Report Definition

iii. Click on the yellow Upload button to browse for and upload the template file that you recently saved.

m. Once you have uploaded the template, you will see its name listed next to the label **Template File** at the bottom of the page, in the **Template Files** section.

n. Change the **Status** from **In Progress** to **Active**
Student/Faculty Information System

BI Publisher – Outline of Steps (Report Developer)

4. **Set Up Report Definition**
   o. Click on the **Output** tab

   ![Diagram of Output Tab]

   p. Select **RTF** as the **Default**
   q. Save the **Report Definition** by clicking on the **Save** button in the lower left
Student/Faculty Information System

BI Publisher – Outline of Steps (Report Developer)

5. Run, View and Save BI Publisher Report

Below are two methods for running, viewing and saving the BI Publisher Report:
(a) Query Report Viewer and (b) Query Report Scheduler

a. Query Report Viewer (Reporting Tools > BI Publisher > Query Report Viewer)
   i. On the Query Report Viewer page, enter criteria and click the Search button
   ii. The RTF file opens, and the top of the first page appears as follows:

   ![Query Report Viewer]

   The RTF file opens, and the top of the first page appears as follows:
Student/Faculty Information System

BI Publisher – Outline of Steps (Report Developer)

5. Run, View and Save BI Publisher Report
   
a. **Query Report Viewer**

   iii. This shows the beginning of a 13-page report that has the institutions sorted and grouped by Country, and then alphabetically by name.

   ![Image of report data]

   **Listing of OIS Approved Institutions by Country**

   **Argentina**

<table>
<thead>
<tr>
<th>Organization ID</th>
<th>Institution Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000071</td>
<td>CIEE: Buenos Aires, Argentina</td>
</tr>
</tbody>
</table>

   **Australia**

<table>
<thead>
<tr>
<th>Organization ID</th>
<th>Institution Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000018</td>
<td>Australian National University - NRS</td>
</tr>
<tr>
<td>5000094</td>
<td>James Cook University - NRS</td>
</tr>
<tr>
<td>500125</td>
<td>Murdoch University - NRS</td>
</tr>
<tr>
<td>0500510</td>
<td>SFS Australia: Rainforest Management</td>
</tr>
<tr>
<td>500252</td>
<td>SIT Australia: Rainforest</td>
</tr>
<tr>
<td>500203</td>
<td>University of Adelaide - NRS</td>
</tr>
<tr>
<td>500213</td>
<td>University of Melbourne - NRS</td>
</tr>
<tr>
<td>500216</td>
<td>University of Queensland - NRS</td>
</tr>
<tr>
<td>500221</td>
<td>University of Sydney - NRS</td>
</tr>
<tr>
<td>500222</td>
<td>University of Tasmania - NRS</td>
</tr>
<tr>
<td>500225</td>
<td>University of Western Australia - NRS</td>
</tr>
</tbody>
</table>
5. Run, View and Save BI Publisher Report

a. Query Report Viewer

iv. There are no page breaks in this report as shown here.

v. At any time you can go back into the template and make formatting or other changes. If you do, you will need to upload the template again in Report Definition to have the latest version associated.

vi. You may save a copy of the report by doing a Save As an RTF file. You can use it as an RTF file or save the RTF file as a Word document.

b. Query Report Scheduler (Reporting Tools > BI Publisher > Query Report Scheduler)
5. Run, View and Save BI Publisher Report

b. Query Report Scheduler
   i. Create a new Run Control. The following page opens.

   ii. Populate the fields as follows:
       a) Data Source Type: The default should be Query. If it is not, change it to Query.
       b) Report Name: You can search for or enter the entire name.
       c) Template ID: If there is just one Template, this field will fill in automatically based on the Report Name. If there is more than one Template, you will choose from the dropdown.
Student/Faculty Information System

BI Publisher – Outline of Steps (Report Developer)

5. Run, View and Save BI Publisher Report

b. Query Report Scheduler

  ii. Populate the fields as follows:
    d) Template As Of Date: To be filled in if the date is a factor.
    e) Note that, if entered a Channel earlier, it is Channel is prepopulated with that entry.
  iii. Click on Save to save this Run Control
  iv. Click on Run
5. Run, View and Save BI Publisher Report

b. Query Report Scheduler

v. Click on OK and then on **Process Monitor**. Basically, run this as you would any Process Scheduler process.

vi. Once the **Run Status** is at **Success** and **Distribution Status** is at **Posted**, click on the link **Go back to Query Report Scheduler**.
5. Run, View and Save BI Publisher Report
   
   b. Query Report Scheduler

   vii. Click on the **Report Manager** link. You will see the following:

   viii. Click on the **Report** link (**OIS_APPROVE2 – OIS_APPROVE2.rtf**). When the next page opens, click on the **Name** link (**OIS_APPROVE2.rtf**)
5. Run, View and Save BI Publisher Report
   b. Query Report Scheduler

ix. You will be prompted to save the RTF file.
5. Run, View and Save BI Publisher Report

b. Query Report Scheduler

x. The beginning of the first page appears as shown.

xi. As mentioned above, you can edit, format or make any changes to the RTF template. After you do so, you will need to upload the template again into Report Definition.

For more information on working with BI Publisher, check the SFIS Blog page BI Publisher/ XMLP and the related PeopleBooks pages.